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LET’S MAKE GAMES!
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Interaction
Up/Down Arrow : Go Forwald/Go Back
Left/Right Arrow : Turn Left/Tum Right
Hit Space key while Running : Jump
Hit Spasa key while Stopping : Rest
Left Cantrol = Front Camera
Alt: LookAt Camera
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WHO ARE WE?
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Pablo Velasco

pvelasco@cc.au.dk =

Vitoria Frau

wttona.frau@cc.au.dk
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PROGRAM

[
Program - Day 1 (18.05.2026) Adorno 114B  Program - Day 2 (26.05.2026) Adorno 138

Time Topic Time Topic

15:00 Welcome and introduction 15:00 Welcome back

15:10-17:30 Introduction to Unity 15:10-17:30 Coding within Unity

17:30-18.00 Challenge of the day 17:30-18:00 Challenge of the day
~18:00 Dinner ~18:00 Dinner

18:45 Wrap-up 18:45 Wrap-up

https://vittoriafrau.github.io/projects/codingbynight-videogame.html
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REPOSITORY

https://qgithub.com/VittoriaFrau/CodingByNightVideoGameEdition
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GAME PLAYING ¥ GAME DEVELOPING
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MANY ASPECTS OF GAME DEV

|
DESIGN QUALITY ASSURANCE
Creative Director
Game Designer
Level Designer
Technical Designer
ENGINEERING PRODUCTION
Develop.ment.Dlrector Exec Producer
Technical Director
Producer
Lead Programmers . .
Associate & Assistants
Developers/Programmers
ART AUDIO
Art D|rec’For Sound Design
Lead Artist :
) : Music/SFX
Computer Graphics Artists Voice Actin
Technical Artist 5
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GAME DEV CONCEPTS APPLY BEYOND GAMES

INTERACTIVE
ENTERTAINME
NT

SERIOU
S
GAMES

INTERACTIVE MEDIA
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“Games can make dreams real. This is the unique characteristic
of interactive entertainment that sets it apart from other forms.
Books and movies can take you away to wonderful places, but
they can’t let you do amazing things”

Ernest Adams, Game Designer



HOW ARE GAMES MADE?
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TARGET AUDIENCE
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NEIGHBORHOOD AKA GAME PLATFORM

Android

Windows Switch Xbox Apple iOS

Web =

Mac = — N PlayStation
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GAME TECHNOLOGY “STACK”

Graphics

Finish work Game-Specific Code

Game Engine
(Graphics, Physics, Input...)

Foundation Operating System

Hardware
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GAME ENGINES

* Provides core game functionality
* Build on top of engine
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UNITY?

* One of the most popular of them all
* Not game genre specific

* Feature rich game engine

* Easy to learn but deep feature set

* Great asset pipeline

* Good documentation and community
* Build to many game platforms
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UNITY EDITOR QUICK REFERENCE
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Camera Manipulation

« Move scene to desired view.

« Select camera.

« Choose GameOQObject->Align with View
« Also can move camera like an object

Essential Unity Concepts

« Project = a folder that contains your entire game and all
its assets (contains a library and assets folder)

» Assets = Items used to make your game including
models, images, sounds, scripts, and prefabs.

Standard Unity View (Window > Layouts > 2 by 3)

1."...."... ANE AFElAATSE= -

1) Scene View = the editor view that allows you
navigate the 3D world, as well as select and
3D assets in the world.

2) Game View = Upon hitting “play” in the top

screen, you’ll compile and preview the game
view. By default the view shows the active ca e S O u rce S
3) Hierarchy Panel = This is a hierarchical list o
the game. You can select objects, rename th
delete them (Shift-Delete)
4) Project Panel = This shows all the usable “as

located in the project’s Assets folder.

L]
5) Inspector = Allows you to view and edit the cd S I t d L k
settings for the selected object in the Scene e e C e I n S
Hierarchy, or Project Panel.

Scene View Controls
| Fote AL LotovseBun Unity Editor Quick Reference «
« Panning = Alt + Middle Mouse Button . .
. Zooming = Alt + Right Mouse Button S | | d es (CO‘ m | n g )
Before you arrive - setup guide Day 1
Before you arrive - setup guide Day 2 (COMING)

CODING
21 April 2026 PABLO VELASCO /TAS ARW
RIKKE HAGENSBY JENSEN



Let's jJump into the editor
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@ Unity Platform Protection: Download Patched Versions of Unity to Protect Your Games & Apps. Learnmore [ X

?Hub
New project

W Getsetup ; -
3D (Built-In Render Pipeline)

& Projects Optimized for 3D applications developed with the

- Templates Built-in Render Pipeline.
= Installs Select an Editor version, then choose a template to start your project.
& Read more
" Learn Editor version

Resources ¥ 5000 3.0 e Unity organization

vittoriafrau
Licenses

Project name
@ My project

Location

Q w7 Learning : /Users/au758864/Visual Studio Code Pr...

® ‘- Use Unity Version Control @&
SRS Pl

Universal 2D Universal 3D High Definition 3D Get Started With Unity 3D (Built-In Render Pipeline)

This is an empty project configured for 2D The URP (Universal Render Pipeline) blank The HDRP (High Definition Render Pipeline) In this brief quided tour, you'll learn about the Optimized for 3D applications developed with
apps. It uses Unity’s Universal Render tempiate includes the settings and assets you blank template includes the settings and core parts of the Unity Editor and build your the Built-in Render Pipeline.

Pipeline pre-configured with 2D Renderer. need to start creating with URP. Equipped... assets you need to start creating with HDR... first 3D scene

& Read more & Read more & Read more & Read more & Read more

A% Sample

Essentials Pathway Universal 3D sample High Definition 3D sample Mixed Reality (MR) MR Multiplayer Tabletop Template
In this Learning Pathway, you'll learn the These four environments showcase the Walk through a High Definition Render Unity's Mixed Reality (MR) Template provides The MR Multiplayer Tabletop Template
essentials of 2D, 3D, Audio, and versatility, scalability, and customizability of Pipeline (HDRP) demo and learn how to a starting point for mixed reality development combines XRI, ARF, NGO, and UGS to cr¢
Programming. Acquiring these skills will giv... the Universal Render Pipeline (URP). The.. develop state-of-the art graphics on high-... in Unity. The template configures project... a starting point for Tabletop MR Multiplay

&9 Read more & Read more & Read more & Read more & Read more

ate
er

4% Sample ' | A% Sample . h i AS Samplie

Settings *
Vv

VR Multiplayer
The VR Multiplayer Template combines XRI, Quickstart your Virtual Reality (VR) The AR Mobile Project Template configures A Multiplayer FPS template sample that uses A Multiplayer Third Person Gameplay

R AR Mobile Multiplayer FPS Multiplayer Third Person Gameplay -+ Create project




P Unity6 | @Clv @ AssetStorev & Unity VCS > ] & 9 Q [ELayout ¥

= Hierarchy = ®» Game : © Inspector

4+ o 2 [F]Center v Q@ Local v ame v Display1 ¥ Free Aspect v Scale @
R New Scene* :
& Main Camera
(D Directional Light

) Cube
:“‘ o\
I Project B Console a
+ Q 7 e € 0O 14
w Favorites 4 Assets » Scenes

Q All Materials

Q All Models
Q, All Prefabs
[aw Assets

T RVELCHELS BrightDay New Scene  SampleSce...
B Scenes

[a@ Supercyan Free Forest Sa

e Materials b
e Models

e Prefabs

B Scenes

BB Shaders

e TerrainLayers

BB Terrains

B® Textures

Bunity—‘chan! - o
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@Clv

W AssetStorev &

! Unity 6

"= Hierarchy # Scene

+v «
R New Scene*

2 Main Camera

D Directional Light

& Cube

I Project B Console

+
% Favorites 4 Assets > Scenes
OWNRVEICES b

Q, All Models

Q All Prefabs

(a9 Assets
e Materials BrightDay New Scene
BB Scenes
(& Supercyan Free Forest Sa

| T RVEICHELE
B® Models
Bm Prefabs
B Scenes
[ ISEEIES
e TerrainLayers
T REREIRE
e Textures
(@ unity-chan!

& Center v (QLocal v 1

Unity VCS =

BBy ©

Hierarchy: Lists all th"e Game

objects inside
the current scene

ils

QO B O e ¥

SampleSce...

a® Game

@ Game

Display 1

v Free Aspect

2 e

Inspector: lists all the
components of the
selected game object

¢ O

v Scale (

14

- Tag Untagged

L Transform

Position

Rotation

Scale &R

& 9 Q [ Layout ¥

v Layer Default

X 0.07154 Y O
X 0 Y O
X 1 Y 1

A Cube (Mesh Filter)

Mesh

B v Mesh Renderer

Materials
Lighting
Cast Shadows

Receive Shadows

H Cube

On
v

Contribute Global lllul

Probes
Light Probes
Reflection Probes
Anchor Override
Additional Settings
Motion Vectors

Dynamic Occlusion

Ng v Box Collider
Edit Collider

Is Trigger
Provides Contacts
Material

Center

Size

Layer Overrides

Light Probes

Blend Probes
Blend Probes

None (Transform)
Per Object Motion

v

£

None (Physics Material)
X 0 Y O
X 1 Y 1

' Default-Material (Material)

Standard

Add Component

o
=

Static ~

v

e i
25.89841




P Unity6 | @QClv @ AssetStorev =

= Hierarchy

+v «
R New Scene*
2 Main Camera
D Directional Light
& Cube

I Project B Console

+
w Favorites
WAV EICHELS
Q, All Models
Q, All Prefabs

(a9 Assets
e Materials
BB Scenes
(& Supercyan Free Forest Sa
| T RVEICHELE
B® Models
Bm Prefabs
B Scenes
[ ISEEIES
e TerrainLayers
T REREIRE
e Textures
[a@ unity-chan!

Unity VCS =

a8 : # Scene

v Plocal v 1 v L~

i
Game object manipulation
Buttons

= .
@ K T #H O Q ®» O e B

4 Assets » Scenes

3

BrightDay New Scene  SampleSce...

a’m Gamt

@ @ Game

visplay |

v rree Aspect

2 e

¢ O

v Scale ( ~

14

S 9 Q [ELayoutv @

O Inspector =)

2 Cube Static ~
Jntagged v Layer Default v
ansform e

X 007154 Y O Z 25.89841
Rotation X 0 Y O Z 0
Scale R X 1 Y 1 Z 1
BE§  Cube (Mesh Filter) Q@
Mesh H Cube ®
B v Mesh Renderer o
Materials 1
Lighting
Cast Shadows On v
Receive Shadows v
Contribute Global lllul
Light Probes
Probes
Light Probes Blend Probes v
Reflection Probes Blend Probes v
Anchor Override None (Transform) ®
Additional Settings
Motion Vectors Per Object Motion v
Dynamic Occlusion v
Ng v Box Collider o
Edit Collider P
Is Trigger
Provides Contacts
Material None (Physics Material) ®
Center X 0 Y O
Size X 1 Y 1
Layer Overrides
' Default-Material (Material) 0 :
Standard Edit... = v

Add Component

O




If you make changes in play mode,
they are not going to be saved!!



Hint: change the color of the background in play mode

Unity -> Preferences -> Colors -> Play Mode tint






Exercise: Extend the playground

Use the scene you already made and add the following:
1. Rename your objects in the Hierarchy: Ground, Light, Cube, Sphere, Capsule.

2. Duplicate the sphere 3 times and place the copies as platforms across the plane. Use
the inspector to change the scale to: 5,5,5 (spherel); 0.3, 0.3, 0.3 (sphere2), 10,10,10
(sphere3). Add a RigidBody component to each of them.

3. Create one parent object called Arch, then make 3 cubes as children: Left, Right, Top.
Drag them under Arch in the Hierarchy.

4. Select the capsule and add a player tag in the Inspector.

5. Create some walls at the edge of the plane.



assetstore.unity.com

Shop 250+ top new assets — all 50% off

? AssetStore Q  Search for assets 9 & ®

3D 2D Add-Ons Audio Al Decentralization Essentials Templates Tools VFX Sell Assets

i Over 11,000 five-star assets @ Rated by 85,000+ customers & Supported by 100,000+ forum members @ Every asset moderated by Unity

Home > 3D > Vegetation > Environment Pack: Free Forest Sample

Environment Pack: Free Forest
2R Sample

<_> Supercyan *kkkk (18) | @ (2667)
FREE

®© 536 views in the past week

Add to My Assets ’ Q ’

0

B

[

-1

)

assetstore.unity.com C fl] + [[_ )

Shop 250+ top new assets — all 50% off

? AssetStore Q  Search for assets o o

3D 2D Add-Ons Audio Al Decentralization Essentials Templates Tools VFX Sell Assets

i Over 11,000 five-star assets @ Rated by 85,000+ customers & Supported by 100,000+ forum members @ Every asset moderated by Unity

> Unity-Chan! Model

itv- 1
08 Unity-Chan! Model

unity-chan! % %k Kk Kk (2889) @ (26880
FREE

© 1307 views in the past week

Add to My Assets ‘ ) ‘

License agreement Standard Unity Asset Store EULA

License agreement  Standard Unity Asset Store EULA License type Extension Asset
License type Extension Asset File size 106.1 MB
File size 19.7 MB Latest version 1.2.2
‘ Latest version 2.01 Latest release date Jun 12, 2020
MORE VIDEOS MORE VIDEOS

; Latest release date Oct 2, 2024 Original Unity version 2018.4.0
Original Unity version 2022.3.32 Support Visit site

Support Visit site

Frequently bought together

Frequently bought together

@

. = °0 WZE
easy —2
s Socket.I0 viie
sC-Rcmy
Overview Package Content Releases Reviews Publisher info Q Asset Quality Overview Package Content Releases Reviews Publisher info Q Asset Quality Easy Save -... Socket.lO V2... Dynamic Bone
EasyRoads3... POLYGON - ... Stylized Natu... %ok %k ok (1036) Yok ok ok (655)
% %k ok ok (704) % % % % % (80) % %k ok v (238) €54.28 €4.60 €18.40
€41.40 €45.99 €13.71

Colorful hand painted Free Forest Sample includes a ready to use demo scene
with free assets to play with! Excellent for testing out assets and physics!

Add all 3 to cart

Render pipeline compatibility A

The Built-in Render Pipeline is Unity's default render pipeline. It is a ¢

for customization. The Universal Render Pipeline (URP

The 3D model girl "Unity-chan!" (Kohaku Ootori) has come from the Japanese
game scenes!
Enjoy making games with her!

Add all 3 to cart

Official Website

What is included:

https://assetstore.unity.com/packages/3d/vegetation/environment-pack-free-
forest-sample-168396

https://assetstore.unity.com/packages/3d/characters/unity-chan-model-18705
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All pink? Don’t worry

® \Window -> Rendering -> Render Pipeline Converter

$ Render Pipeline Converter

® Select all -> Initialize Converters

Built=in to LURP v

Q |'_i'2- tool converts project elements from the Built-in Render Pipeline to URP, Click the converters below to see more
nfoarmatlon.
‘ C O n V e rt a S S e t S + Renderer and Settings Assets Setup 0/0 selected

@ No items found to convert 0- 0 0oh O

~ Material Upgrade 26/26 selected
Conversion Complete 0- 04k O 26

+ Animation Clip Converter 0/0 selected
@ Mo items found to convert 0- 04 OO 0O

+ Readonly Material Converter 0/0 selected
@ No items found to convert 0- 0 0oh O

Lac D YOuUr project be fore proceec 19,

Initialize Converters




Trust me on

@ Project Settings

£ Project Settings

Edit -> Project Settings -> ——
Player -> Active Input Oedes e o

Graphics Identification

Handlig -> Both + Restart

: J Backent Mono
Preset Manage Api Compatibility Level* .NET Standard 2.1
sty impatibility Level*  Default (.NET Framework)

=scene Template

Scrnpt Execution Order

Use increamental GC* w
Allow downloads ove ITP Mot allowed

Active Input Han 19" Both

XR Plugin Ma 1agemen

Platform Default

Shader Variant Loadina Settinas




Our character

Assets -> unity-chan -> Unitychan! Model —>
Prefabs -> for locomotion ->
unitychan _dynamic _locomotion




Sound in Unity

An Audio Clip is the sound file,
such as music or ambience.

An Audio Source is the
component that plays that clip.

An Audio Listener is the “ear”
of the scene, usually attached
to the camera.

il v Audio Source

Cutput
WiLte

Bypass Effects

Bypass Listener Effects

Bypass Reverb Zones

Play On Awake

Spatial Blend

Reverbh Zaone Mix

MNone (Audio Clip)

Mone (Audio Mixer Group)




Useful Unity Resources

* Unity manual: https://docs.unity3d.com/Manual/index.html

* Brackeys: https://www.youtube.com/Brackeys High-quality tutorials on Unity

* Unity asset store: https://assetstore.unity.com/

* Turbo Squid:_https://www.turbosquid.com/

* Mixamo: https://www.mixamo.com/

* Sketchfab: https://sketchfab.com/

35
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Challenge of the day

Look in the Asset Store for free assets to import into your project and
customize your forest!

Add a nice soundtrack to your game
Modify the skybox of your game
Add and modify the lights of the forest

Place 5—-10 collectible objects in the map, hide them with the inspector, and
add particle effects to make them noticeable

(Advanced) Create simple animations with animator
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